NI 9211 Calibration Procedure

This document contains information about calibrating the National
Instruments 9211 module using NI-DAQmx. This calibration procedure is
intended for metrology labs.

This document does not discuss programming techniques or compiler
configuration. The NI-DAQmx driver contains online help files that have
compiler-specific instructions and detailed function explanations. You can
install these help files when you install NI-DAQmx on the calibration
computer.

The NI 9211 should be calibrated at a regular interval as defined by

the measurement accuracy requirements of your application. National
Instruments recommends that you routinely perform a complete calibration
at least once every year. You can shorten this interval based on the accuracy
demands of your application or requirements of your processes. Adjusting
the calibration constants must be done by a factory calibration at NI.
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The following conventions appear in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names and hardware labels.

Ttalic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Monospace text denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

Software and Documentation Requirements

Software

This section describes the software and documentation required for
calibration.

Install NI-DAQmx 8.1 or later on the calibration computer. NI-DAQmx
includes high-level function calls to simplify the task of writing software to
calibrate devices. You must have the proper device driver installed on the
calibration system before calibrating the device.

@ Note NI recommends that you install the NI-DAQmx driver software before physically
installing the NI 9211. NI-DAQmx, available at ni . com/downloads, configures and
controls the NI 9211.

NI 9211 Calibration Procedure

2 ni.com



NI-DAQmzx supports a number of programming languages, including
LabVIEW, LabWindows™/CVI™, Microsoft Visual C++ 6.0, Microsoft
Visual Basic 6.0, Microsoft .NET, and Borland C++.

You can access the NI-DAQmx header file, NIDAQmx . h, like any standard
library. You can find examples of how to use the NI-DAQmx driver in the
Program Files\National Instruments\NI-DAQ\Examples
directory.

Documentation

You might find the following documentation helpful as you write the
calibration procedure:

NI-DAQmx Help—This help file contains general information about
measurement concepts, key NI-DAQmzx concepts, and common
applications that apply to all programming environments. To access
this help file, select Start»All Programs»National Instruments»
NI-DAQ»NI-DAQmx Help.

NI-DAQmx C Reference Help—This help file contains C reference and
general information about measurement concepts. To access this help
file, select Start»All Programs»National Instruments»NI-DAQ»
NI-DAQmx C Reference Help.

DAQ Getting Started Guide for NI-DAQ 8.0 or later—This guide
describes how to install NI-DAQmx for Windows software and
NI-DAQmzx-supported DAQ devices, and how to confirm that your
device is operating properly. To access this guide, select Start»
All Programs»National Instruments»NI-DAQ»DAQ Getting
Started Guide.

Note The documents above are installed with NI-DAQmx. You can also download the
latest versions from the NI Web site at ni . com/manuals.

© National Instruments Corporation

NI 9211 Operating Instructions— This document contains
information about specific device features. You can download the
latest version of this document from the NI Web site at ni . com/
manuals.
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Calibration Requirements

Test Equipment

National Instruments recommends that you use the following equipment
for calibrating the NI 9211:

e  Fluke 5700A calibrator. If that instrument is unavailable, use a
high-precision voltage source with an accuracy of at least 10 ppm and
an output impedance of less than or equal to 50 Q.

e NI cDAQ-9172 chassis.

Test Conditions

Follow these guidelines to optimize the connections and the environment:

*  Keep connections to the device as short as possible. Long cables and
wires act as antennae, picking up extra noise that can affect
measurements.

»  Use shielded copper wire for all cable connections to the device.
Use twisted-pair wire to eliminate noise and thermal offsets.

*  Maintain an ambient temperature of 23 +10 °C. The device
temperature will be greater than the ambient temperature.

*  Keep relative humidity below 80%.

e Allow a warm-up time of at least 10 minutes to ensure that the
measurement circuitry is at a stable operating temperature.

Calibration Process

This section provides instructions for verifying the NI 9211.

Calibration Process Overview
The calibration process consists of the following steps:
1. Initial Setup—Configure the device in NI-DAQmx.

2. Verification Procedure—Verify the existing operation of the device.
This step confirms whether the device was operating within its
specified range prior to calibration.

3. Adjustment—Submit the device to NI for a factory calibration to
adjust the calibration constants.
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The first two steps are explained in the following sections.

Initial Setup

You must configure the device in Measurement & Automation Explorer
(MAX) to communicate with NI-DAQmx.

Complete the following steps to configure a device in MAX:
1. Install the NI-DAQmx driver software.

2. Make sure that no power is connected to the module terminals. If the
system is in a nonhazardous location, the chassis power can be on
when you install the module.

Insert the module into an available slot in the cDAQ-9172 chassis.
4. Launch MAX.

5. Right-click the device name and select Self-Test to ensure that the
device is working properly.

@ Note When a device is configured with MAX, itis assigned a device name. Each function
call uses this device name to determine which DAQ device to calibrate. This document uses
dev1 to refer to the device name. In the following procedures, use the device name as it
appears in MAX.

Verification Procedure

Verification determines how well the device is meeting its specifications.
By completing this procedure, you can see how the device has drifted over
time, which helps you determine the appropriate calibration interval for
your application. The tables in the Device Test Limits section show all
acceptable settings for the device type. Throughout the verification
process, use Tables 4 and 5 to determine if the device is operating within
its specified range prior to calibration. You must perform verification on all
analog input channels.
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Analog Input Gain Verification

Complete the following steps to test the performance of the analog input

gain of the device:

1. Refer to Table 1 for a list of the NI connection accessories for the
NI 9211 and instructions on connecting the calibrator to the device.

Table 1. NI Connection Accessories

Device

Connection Accessory

Connection Instructions

NI9211

NI 9932 Strain relief & high
voltage screw terminal
connector

Connect the positive output of the calibrator to
all positive terminals (pins 0, 2,4, and 6) and the
negative output of the calibrator to all negative
terminals (pins 1, 3, 5, and 7) and COM (pin 9).
If the calibrator has a guard connection, connect
that terminal to COM instead of connecting
COM to the negative output.

2. Set the calibrator voltage to a Test Point value indicated in Table 4.
NI recommends that you verify all values, although you can save time
by verifying only the values used in your application.

3. Ifyouuse C function calls, create a task using DAQmxCreateTask, as
shown in the following table. If you use LabVIEW, skip this step. The
task is created in step 4 in LabVIEW.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call DAQmxCreateTask with the
following parameters:

taskName: ATVerificationTask
taskHandle: staskHandle

LabVIEW does not require this step.

NI 9211 Calibration Procedure

ni.com




4. Create and configure an Al voltage channel through NI-DAQmx using
DAQmxCreateAIVoltageChan (DAQmx Create Virtual Channel
VI), as shown in the following table. Use Table 4 to determine the

minimum and maximum values for the device.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call
DAQmxCreateAIVoltageChan
with the following parameters:

taskHandle: taskHandle
physicalChannels: dev1/ai0
nameToAssignToChannel:
myVoltageChannel
terminal Config:
DAQmx_Val_Cfg_Default
minVal: -0.08

maxVal: 0.08

units: DAQmx_Val_Volts
customScaleName: NULL

Differential *

I/0 g

heesical channels|  EEEEgrr-~rer~e--{FL0

in AlVolkage

Frar
G

5. Configure the timing properties for the voltage acquisition using
DAQmxCfgSampClkTiming (DAQmx Timing VI), as shown in the
following table.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call
DAQmxCfgSampClkTiming
with the following parameters:

taskHandle: taskHandle
source: NULL

rate: 7.14

activeEdge:
DAQmx_Val_Rising
sampleMode:
DAQmx_Val_FiniteSamps

Fi]
¥ = ror auk
Sample Clock 'I L_ beet]

kask ouk
r

sampsPerChan: 50 Errar in
D o R
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6. Enable autozero through NI-DAQmx using
DAQmxSetChanAttribute (DAQmx Channel Property Node),
as shown in the following table.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call DAQmxSetChanAttribute
with the following parameters:

taskHandle: taskHandle
channel: “*

Attribute:
DAQmx_AI_AutoZeroMode
Value (Autozero on): 10164

E; == DAy Channel g

[Every Sample *|r

A1 A0koZeroMode

7. Start the acquisition using DAQmxStartTask (DAQmx Start Task VI),

as shown in the following table.

NI-DAQmx Function Call

Call DAQmxStartTask with
the following parameter:

taskHandle: taskHandle

LabVIEW Block Diagram
bask out
(I 7o
= CATY
{5 ==-=-L_
[Sauk 0|

8. Acquire 50 points of voltage data using DAQmxReadAnalogF64
(DAQmx Read VI), as shown in the following table.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call DAQmxReadAnalogF64 with the
following parameters:

taskHandle: taskHandle
numSampsPerChan: -1
timeout: 10.0

fillMode:
DAQmx_Val_GroupByChannel
readArray: data
arraySizeInSamples: 50
sampsPerChanRead: sread
reserved: NULL

askichannels in kask ouk
/0 el W71
Eimeu:uut
} oy :
(LA |
Frat in Analog 10 DEL - rrufur ok
Eol Koo | 1Chan WSamp s | 5
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9. Average the voltage values that you acquired. Compare the resulting
average to the Upper Limit and Lower Limit values listed in Table 4.
If the result is between these values, the device passes the test.

10. Clear the acquisition using DAQmxClearTask (DAQmx Clear Task
VI), as shown in the following table.

NI-DAQmx Function Call LabVIEW Block Diagram

Call DAQmxClearTask with the following
parameter:

taskHandle: taskHandle &
i e

T

11. Repeat steps 3 through 10 for all channels and all values.

12. Disconnect the calibrator from the device.

Analog Input Offset Verification

Complete the following steps to test the performance of the analog input
offset of the device:

1. Use a copper wire to connect a 0 € short circuit to the device between
the positive terminals, the negative terminals, and COM.

2. If youuse C function calls, create a task using DAQmxCreateTask, as
shown in the following table. If you use LabVIEW, skip this step. The
task is created in step 3 in LabVIEW.

NI-DAQmx Function Call LabVIEW Block Diagram

Call DAQmxCreateTask with the

following parameters:
LabVIEW does not require this step.

taskName: AIVerificationTask
taskHandle: staskHandle
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3. Create and configure an Al voltage channel through NI-DAQmx using
DAQmxCreateAIVoltageChan (DAQmx Create Virtual Channel
VI), as shown in the following table. Use Table 5 to determine the
minimum and maximum values for the device.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call
DAQmxCreateAIVoltageChan
with the following parameters:

taskHandle: taskHandle
physicalChannels: devl/ai0
nameToAssignToChannel:
myVoltageChannel
terminal Config:

DAQmx_Val_ Cfg_Default
minVal: -0.08

maxVval: 0.08

units: DAQmx_Val_Volts
customScaleName: NULL

Differential =

inirnum value

aximurm walue

'I |

brpsical channels|  [EEEEgr~r~enenees
] 0

4. Configure the timing properties for the voltage acquisition using
DAQmxC fgSampClkTiming (DAQmx Timing VI), as shown in the
following table.

NI-DAQmx Function Call

LabVIEW Block Diagram

CallDAQmxCfgSampClkTiming
with the following parameters:

taskHandle: taskHandle
source: NULL

rate: 7. 14

activeEdge:
DAQmx_Val_Rising
sampleMode:
DAQmx_Val_FiniteSamps
sampsPerChan: 50

' Sample Clock = L_

kask ouk
r

7
ror ouk
Pooh
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5. Set autozero through NI-DAQmx using DAQmxSetChanAttribute
(DAQmx Channel Property Node), as shown in the following table.
Use Table 5 to determine when to set autozero to Every Sample or

None.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call DAQmxSetChanAttribute
with the following parameters:

taskHandle: taskHandle
channel: "+

Attribute:
DAQmx_AI_AutoZeroMode
Value (Autozero on): 10164
Value (Autozero off): 10230

ﬂ == Dacm: Channel ﬂ
F AL AukoZeroMode

6. Start the acquisition using DAQmxStartTask (DAQmx Start Task VI),
as shown in the following table.

NI-DAQmx Function Call

LabVIEW Block Diagram

Call DAQOmxStartTask with
the following parameter:

taskHandle: taskHandle

kask ouk

|

Fl] I:0
"'d-m
LE: ======-L=
IF-': ¥ LT

7. Acquire 50 points of voltage data using DAQmxReadAnalogF64
(DAQmx Read VI), as shown in the following table.

NI-DAQmx Function Call LabVIEW Block Diagram
Call bAQOmxReadAnalogF64 with the
following parameters:
taskHandle: taskHandle aIsmchanneIs in ta:i':""t
numSampsPerChan: -1
timeout: 10.0 .
. Elmeuut

fillMode: 2 D | b
DAQmx_Val_GroupByChannel ﬁ%
readArray: dat E—

ray: data rrorin Analog 1D DBEL rror out
arraySizeInSamples: 50 Fut Kool | 1Than MSamp ]
sampsPerChanRead: &read
reserved: NULL
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8. Average the voltage values that you acquired. Compare the resulting
average to the Upper Limit and Lower Limit values listed in Table 5.
If the result is between these values, the device passes the test.

9. Clear the acquisition using DAQmxClearTask (DAQmx Clear Task
VI), as shown in the following table.

NI-DAQmx Function Call LabVIEW Block Diagram

Call DAQmxClearTask with the following
parameter:

taskHandle: taskHandle &
— =TT

[ e

10. Repeat steps 2 through 9 for all channels and all values.

Specifications

The values in the following table are based on calibrated scaling
coefficients, which are stored in the onboard EEPROM. The following
calibration specifications are for 23 +10 °C.

Table 2. NI 9211 Accuracy

Gain Error Offset Error

0.05% 20 uV

@ Note The Device Test Limits in Tables 4 and 5 include an uncertainty of up to 50  output
impedance. Use Table 3 to add additional uncertainty if you use a calibrator with an output
impedance of greater than 50 Q.

Table 3. Additional Errors from Output Impedance

Gain Error Offset Error

0.05 ppm/Q 0.07 uV ppm/Q
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Device Test Limits

Using the Tables

Tables 4 and 5 list the specifications that the NI 9211 meets if it has been
one year between calibrations.

The following definitions describe how to use the information from
Tables 4 and 5.

Range

Range refers to the minimum or maximum voltage range of an input signal.

Test Point

The Test Point is the voltage value that is input or output for verification
purposes. This value is broken down into two columns—Location and
Value. Location refers to where the test value fits within the test range.
Value refers to the voltage value to be verified. Max refers to maximum
value, Min refers to minimum value, and Mid refers to mid-scale.

1-Year Limits

The I-Year Limits column contains the Upper Limits and Lower Limits for
the test point value. That is, when the device is within its 1-year calibration
interval, the test point value should fall between these upper and lower limit
values.

Table 4. NI 9211 Analog Input Values for Gain Verification

Range (V) Test Point 1-Year Limits
Minimum | Maximum Location Value (V) Lower Limit (V) | Upper Limit (V)
—-0.080 0.080 Max 0.075000 0.0749425 0.0750575
—-0.080 0.080 Min -0.075000 -0.0750575 —0.0749425
Table 5. NI 9211 Analog Input Values for Offset Verification
Range (V) Test Point 1-Year Limits
Lower Upper Autozero
Minimum | Maximum | Location | Value (V) Limit (V) Limit (V) Mode
—0.080 0.080 Mid 0.000000 | —0.0000200 | 0.0000200 | Every Sample
—0.080 0.080 Mid 0.000000 | —0.0000200 | 0.0000200 None

© National Instruments Corporation
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Where to Go for Support

The National Instruments Web site is your complete resource for technical
support. At ni.com/support you have access to everything from
troubleshooting and application development self-help resources to email
and phone assistance from NI Application Engineers.

National Instruments corporate headquarters is located at

11500 North Mopac Expressway, Austin, Texas, 78759-3504.

National Instruments also has offices located around the world to help
address your support needs. For telephone support in the United States,
create your service request at ni . com/support and follow the calling
instructions or dial 512 795 8248. For telephone support outside the United
States, contact your local branch office:

Australia 1800 300 800, Austria 43 0 662 45 79 90 0,
Belgium 32 0 2 757 00 20, Brazil 55 11 3262 3599,

Canada 800 433 3488, China 86 21 6555 7838,

Czech Republic 420 224 235 774, Denmark 45 45 76 26 00,
Finland 385 09 725 725 11, France 33 0 1 48 14 24 24,
Germany 49 0 89 741 31 30, India 91 80 41190000,

Israel 972 0 3 6393737, Ttaly 39 02 413091, Japan 81 3 5472 2970,
Korea 82 02 3451 3400, Lebanon 961 0 1 33 28 28,
Malaysia 1800 887710, Mexico 01 800 010 0793,
Netherlands 31 0 348 433 466, New Zealand 0800 553 322,
Norway 47 0 66 90 76 60, Poland 48 22 3390150,

Portugal 351 210 311 210, Russia 7 495 783 68 51,
Singapore 1800 226 5886, Slovenia 386 3 425 42 00,

South Africa 27 0 11 805 8197, Spain 34 91 640 0085,
Sweden 46 0 8 587 895 00, Switzerland 41 56 200 51 51,
Taiwan 886 02 2377 2222, Thailand 662 278 6777,

Turkey 90 212 279 3031, United Kingdom 44 0 1635 523545

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.

© 2006 National Instruments Corporation. All rights reserved. 372137A-01 Dec06
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